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Typeface Conventions
EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEENEEEEEEEEEEENI
Indicates a button, menu selection, tab, dialog box title,
Bold : ;
text to type, selections from drop-down lists, or prompts
on a dialog box.

ScriptLogic may be contacted about any questions, problems or concerns you might
have at:

ScriptLogic Corporation
6000 Broken Sound Parkway NW
Boca Raton, Florida 33487-2742

561.886.2400 Sales and General Inquiries
561.886.2450 Technical Support

561.886.2499 Fax

I,

www.scriptlogic.com

ScriptLogic can be found on the web at www.scriptlogic.com. Our web site offers
customers a variety of information:

* Download product updates, patches and/or evaluation products.
= Locate product information and technical details.
* Find out about Product Pricing.

=  Search the Knowledge Base for Technical Notes containing an extensive
collection of technical articles, troubleshooting tips and white papers.

=  Search Frequently Asked Questions, for the answers to the most common non-
technical issues.

* Participate in Discussion Forums to discuss problems or ideas with other users
and ScriptLogic representatives.
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Introduction

Enterprise Security Reporter is a powerful and comprehensive reporting solution for
documenting, NTFS, server registries, and file share permissions in Windows-based
networks. As networks grow in size and complexity, visibility into overall
permissions quickly becomes a business-critical security concern. Native, built-in
operating system tools are insufficient to provide the summary or detailed reports
needed to understand and proactively manage access. At best, native tools provide
inspection of individual properties of your current configuration.

Enterprise Security Reporter is a solution focused on enterprise-wide Windows
network permissions. By inspecting Active Directory™, NTFS, server registries, and
file shares, Enterprise Security Reporter produces the vital information needed to
document security and take proactive action. Whether directly (such as NTFS
permissions) or indirectly (such as group membership reporting), Enterprise Security

Reporter provides summarized reports of access to files, folders, shares, registry
keys, printers and services.

‘ Enterprise Security Reporter 3.0 BETA -- ScriptLogic Corporation

File Tools Help

BT E&lad

E RN

@ Domains )’ i@ Computers r{g Discavery Groups r;fg Manage Discoveries I

| Computer [Domain [ Type [ & ltems |.;I Paths | @ Feaisiy keys | A Options
é PC-45678 ACME tember Server
E W4 WINZESYR  ACME Primary Domain Controller

I Discavery Parameters

I# Local accounts

¥ Local security policy
¥ Ewent log configuration
I# Priters

¥ Services

¥ Shares

™ Registy keys

ﬁ Enterprise Security Reporter 3.0
Eile Tools Help

BRI &ld

& Domains I/a Computers I/,gfg Discoven Eruups} L‘gManageDlscovenesl

[Dlscuvew servers

[- D[]

ERN-NF]

Connection: server=Wh 44/ IN2KSWR

& Cancel |ﬁ| Lid

W Move |

@ Status ¢ Logs ¢ Emars

Select: |VMA-WINZKSVR - O e Stop | £a Install.. | =) Remove | ¥ Refreshevers [5  secs. (& Refresh
Current discovery queus Select job
Type [ Path [ Status [ Elopsed [ Priodty [ [4/21/2006 - 11:34 AM [Firished] [cunent] =l
Domsin  LDAP//DC=aomeDC=com  Firihed 000006 Homal | -
= — = Computer wmd-winZksvr.acme.com Added Nomal £ Set Curent |K} Delste Job
@ Add &, Search | i Computer  pc-45678. acme. com Stated  00:0210  Nomal

|_Object Tupe: | Scan Count I Digcover Count | Elapsed Time |
Group 21 2 2
Group Member 19 19 2
User o 1} 1s
Account Rights 35 s} 1s
Audit Policy 9 q 1s
Computer Palicy 9 9 1z
Event Log [ B 1z
Printer 1 1 1s
Service 70 70 Bs
Share El El 1s
Yolume: 1 1 1z
Folder 27 2F 13
File: = kil 13
ACL 232 43 13s
ACE 1217 224 13s
4 | |

|EDnnEEliDn server=i 4 WINZKSWR dalahasnlD\scuvew server: VM AWINZKSVR

1 pending, 1 started

Licenses: 100 Remaining: 53
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Comprehensive Discovery

Enterprise Security Reporter collects data by connecting to and extracting relevant
information from servers on your network. You can add servers individually or
create discovery groups to define sets of servers to be queried. To minimize server
loading, Enterprise Security Reporter performs its discovery and extraction without
the use of agents. Enterprise Security Reporter has the granularity to select the
information to be collected, including:

Groups (including memberships)

Users (including extended information)

Account Rights

Computer Policies

Printers (and permissions)

Services (and permissions)

Shares (and permissions)

Registry keys (and permissions)

Volumes, Folders, and Files (and permissions)

Turnkey and Custom Reports

Enterprise Security Reporter has over 80 built-in reports, encompassing the most
common reporting needs. Reports are based on the information collected using the
Discovery Console. A simple selection of the type of report (such as Computer
Policies, Group Memberships or Permissions) and the specific report you wish to
run, and you instantly have an organized, useful set of information at your
fingertips. You also can design custom reports using a report generator that creates
customized professional and thorough reports without writing SQL queries.

# ESR3: Folder Size Report - Sorted By Size H=l
Repart | Results | Quemn
1@
= | 122 Print... ‘ | ‘ &4 | DA s | e ® [ 11 | & Backward  €) Foward
a
Folder Size Report 41 202008 12:05:10 PM
Path Folder Size (Bytes)
um4-win2ksw.acme.com Dizcovery Date: 4/6/2006 6:16:02 PM
Z:\Program FilesiScriptLogic Manager 10,483 364
Z\Program FilesvscriptLogic ManagerDesktopluthority 9,088 714
Z\Program FilesiScriptLogic Managerts Updates 6,072 455
Z:\Program FilesiScriptLogic ManagerScripts 4,540 523
COANMTIEY SV OLsysvollacme.comiscripts 4,540 420
ZProgram FilesvScriptLogic ManagerServices 356,352
CMMNTISY SV OL sy svollacme comPoliciesi{6ACT TB6C-016F-1102-945F -00C04fB354F 3} 4 266
ACHINEWicrasoftWindoves NT\ZGecEdit
CIMMMTYEY SV OLYeysvollacme. comPoliciesi{31 B2F 340-01 D-1102-945F -00C04F BIS4F 9 FMACHIMNE 2,118
CIANMTISY SV 0Ly svolacme comiPolicies){31B2F 340-01 E0-1102-945F -00C04FBIS4F 3} 854 ;I
1 ] K
Completed Elapsed Time: 00:00:23 2
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Discovery Console

Enterprise Security Reporter is designed to collect information from your servers as
quickly and efficiently as possible. The processes of discovering data from your
servers must be completed before you can run any reports.

Important: If you have not yet done so, create the discovery and reporting databases.
The discovery process cannot be configured until this step has been completed.
See Creating a New Database.

P Click Start, point to Programs » ScriptLogic Corporation > Enterprise Security
Reporter 3, and then select Discovery Console.

After starting the Discovery Console, you see the main application window
where you can perform all the actions necessary to configure and manage the

discovery process.

i Enterprise Security Reporter 3.0
File Tools Help

B d BEIEAlD

@ Daomainz ra Computers rﬁ Dizcovery Groups rﬁs Manage Discoveries I

Darnain | Digcaven DC

| Dorain Type

Add... |® Remove |

2 v | s

i Discovery Domain Controller

Select dizcovery domain contraller.

o

B Discovery Domain Attributes

I Domain accounts

I™ Sites

I Trust relationships

I Domain contrallsrs

I= Domain computers

[T Origanizational urits

I Synchronize last lagon information

@ sl | & Scheduls

|Connection: server=wh 4 wINZESYR databe|

Licenses: 100 Remaining: 100
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Tabs

Configure domains for discovery. See Configuring Domains for
: Discovery.

Configure computers for discovery. See Configuring Computers.

e l Create and configure groups of domains and servers for

discovery. See Using Discovery Group.

¢ Manage Discoveries I Monitor current discovery and schedule discoveries.

Toolbar

See Launching a Discovery.

& B B & E - E

File Menu

Connect to the discovery server and database. See Installing the Discovery
Engine.

Set global options for discovery. See Setting Global Discovery Options.
Open the Database Maintenance Utility where you can manage the
discovery database. See Starting the Database Utilities.

Open the Database Maintenance Utility where you can manage the reporting
database. See Starting the Database Utilities.

Open the Enterprise Scopes dialog box where you can group multiple
computers together into a scope against which you can run a single report.

Open the Reporting Console where you can select reports to run against the
discovery data you collected. See Error! Reference source not found..

Install the Discovery Engine. See Installing the Discovery Engine.

Launch the discovery process for the selected domain(s) or group(s).
See Launching a Discovery.

[ Connect To Database...

E, Impart Discovery Configuration. .

Eﬂ' Expaort Discovery Configuration. .

Exit

Connect to Database Connect to the discovery server and database. See Installing the
Discovery Engine.

Import Discovery Load discovery settings from an ESR 3 Discovery Configuration

Configuration (*.xdc) file. See Exporting Discovery Configuration Settings.

Export Discovery Save discovery settings to an ESR 3 Discovery Configuration

Configuration (*.xdc) file. See Importing Discovery Configuration Settings.

Exit

Exit Enterprise Security Reporter.
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Tools Menu

Tools

Configure global exdude paths. ..

Configure enkerprise scopes, .,

Configure discovery database. ..

Configure reporting database. ..

View licensed objects...

. Install Discovery Engine Service. ..

Beqgin discavery

)
&
Q Open reporting consale. ..
P
J:
T
B

Menu Option

Configure global
exclude paths

Configure discovery
database

Configure reporting
database

Configure enterprise
scopes

Open reporting
console

View licensed objects

Install Discovery
Engine Service

Begin discovery

Help Menu

Help

Contents. ..

Abouk

Menu Option
Contents
About

Description

Set global options for discovery. See Setting Global Discovery
Options.

Open the Database Maintenance Utility where you can manage
the discovery database. See Starting the Database Utilities.

Open the Database Maintenance Utility where you can manage
the reporting database. See Starting the Database Utilities.

Open the Enterprise Scopes dialog box where you can group
multiple computers together into a scope against which you can
run a single report. See Using Enterprise Scopes.

Open the Reporting Console where you can select reports to run
against the discovery data you collected. See the Reporting Guide.

Manage the computers applied to your site license. See Managing
Licenses

Install the Discovery Engine. See Installing the Discovery Engine.

Launch the discovery process for the selected domain(s) or
group(s). See Launching a Discovery.

Description
Open online help.

View information about the version of Enterprise Security Explorer

installed on your computer, to apply a license file, or to visit the
ScriptLogic website.
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Status Bar

The status bar at the bottom of the window displays the connection server and
database, the discovery server, the number of pending and started discoveries, and
the number of total and remaining licenses.

|’*'*"°"+—“T“*‘“"‘T"’~ IV by O BRI o TN N P e

|C0nnection: zerver=\yh4-WIN2KSYR database=dbESR3 |Discover_l,l zerver Vi 4WWIN2ESVR |D pending, 0 started |Licenses: 100 Remaining: 98 |

INSTALLING THE DISCOVERY ENGINE

Important: You must install the Discovery Engine before starting a discovery. To
check if the Discovery Engine is installed, open the Manage Discoveries tab, and
then open the Select discovery server drop-down list. If the computer where the
Discovery Console is installed appears, then the Discovery Engine is installed.

ﬂ Discovery Console

File Tools Help

= /! 3 . .
@ Domains r@ Computers @3 Discovery Groups /ﬁ I anage Discoveries

Select discovery server: IVM4-W'|N2KSVH j B Info..

Stop | 2 Install.. | io] Remave | L

LT SRRVt WYy S ST N g QR P S

Important: Installing the Discovery Engine a computer that is running other
ScriptLogic products may cause the computer to reboot. To prevent the reboot,
temporarily shut down any ScriptLogic products or services running on the target
computer before installing the Discovery Engine.

1. Click . Alternatively, select Install Discovery Engine Service from the Tools
menu. The Install Discovery Service box opens.

Note: You also can install the Discovery Engine on the Manage Discoveries tab.
See Managing the Discovery Server.

2. In the Target machine name box, type the name of the computer where the
Discovery Console is installed, or select the computer from the list.

3. In the Domain\username box, type the account name that can run the Discovery
Engine, or click to locate an account name.
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4. In the Password box, type the password.

Important: You must use an account that has a password. For security reasons,
Enterprise Security Reporter will not use a blank password.

ﬂ Install Discovery Service M=l E3

Select the zerver where you would ke to install the dizcoveny service:
El{# Desktop
g Metwark. Meighborhood
El@ Active Directony
E--@ aCME. com
=) Builtin
_| Computers
=13 Domain Contrallsrs
ERRR Y 114/ 2K S
) ForeignSecurityPrincipals
B Spstem
B Users

Taraet machine narne: I Whwmd-winZlsvr acme. com

Damaintusername: IﬁEME‘u&dministrator q;l

I [r——

Password:

ak. I Cahicel |

4

5. Click OK. The Discovery Engine Setup window shows the progress of the
installation of the discovery engine and service.

Enterprise Security Reporter - Discovery Engine Setup...

Setver IhWM4-WIN2KSVF|.AEME.EDM Close |

Server | Log Text |
@ WWbAWINZ . Beaginning installation on remaote zerver MWWk 420N 2K SR ACME . COM
@ WMAMWAMZ.. The agent iz now installed on server WWMAAWINZKSWYR ACME. COM
@ W AWINZ.  Wenfying service ingtallation...
@ WahbAWINZ . Caonfiguring service account
@ WabddawME. Configuing discovery engine
@ Wb AWINZ.,,  Starting the discovery engine
-@ WYMAMINZ L Process complete

6. When you see Process complete, click Close.
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CONNECTING TO THE DISCOVERY DATABASE
If you have more than one discovery server and database, you need to connect to the
one that you want to use.

1. From the File menu, choose Connect to database. The Database box displays the
current discovery server and database. The default database created during the
install process is dbESR3.mdf.

batsbaze |

' windows Authentication  Usemame: I
" 50L Authentication Pazzword: I

Server.  |Wh4-WINZKSVR |
Database: |dbESR3 =

] I Cancel |

2. Choose the type of authentication to use. If you choose SQL Authentication,
enter the user name and password.

3. Choose the discovery server and database to use, and then click OK.

SETTING GLOBAL DISCOVERY OPTIONS

Some settings that affect the discovery process can be set system wide. These options
can be accessed by selecting Configure global exclude paths from the Tools menu.

Excluding Paths on All Computers

Although you can exclude particular paths on a computer-by-computer basis, you
may want to exclude folders on all computers that match a certain name, such as
Temporary Internet Files, System 32, or Winnt.

Important: If you exclude a path and there is a shared folder within that path, those
folders are included in the discovery if the All folders available through public
shares check box is selected on the Items tab for a specific computer. See Selecting
Items for Computer Discovery.

1. Click or choose Configure global exclude paths from the Tools menu. The
Options box opens to the Exclude Paths tab.

2. You can add a path by typing the path or by selecting from a list.

To select paths from a list, click . The Browse for Folder list

appears. Select the path, and then click OK.
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To add a path by typing the name, click . With New exclude path
selected, type the path, and then click off the path.

ﬂgﬂptions

(-] Exclude Paths

@F Registy Keys |

Tl pdd.. |42 Browse.. | &) Delete |

Cloge

4

Important: The folder names must match exactly (except for case), and no
wild cards are permitted. All subfolders are excluded from the discovery.
The path displays in the list.

agﬂptions

\;| Exclude Paths | a‘ Registry Keys |

Path |
1] ©:Program Files

O sdd.. | 93] Browss... | & Delete

Y

To remove a selected path from the list, click £ Delete |

Including/Excluding Registry Keys on All Computers

Although you can include or exclude particular registry keys on a computer-by-
computer basis, you may want to include or exclude registry keys on all computers.

1. Click or choose Configure global exclude paths from the Tools menu. The
Options dialog box opens to the Exclude Paths tab.

2. Open the Registry Keys tab, and then click . The Select Registry Key
list box appears.

21 APRIL 2006



ENTERPRISE SECURITY REPORTER™ 3.0 10

3. Expand the list to locate the key to add or type a path in the Select key above, or
type the key below box.

Note: If you select a key from the list, the Select key above, or type the key
below box becomes unavailable.

ﬂgSelect Registry Key ==

= Registry

- J by Computer [Wh4-4/IM2KSWVR)

- W HEEY_LOCAL_MACHINE

= HARDWARE
O 54M
[y SECURITY
W o F [ARE
BRI SYSTEM
B[]0 HKEY_USERS

Select key above, or type the key below:
I [multiple checked)

Select how you want the key to be treated: * |nclude  Exclude
(]9 I Cancel |
4
4. Select whether to include or exclude the key from the discovery.
5.

Click OK. The key displays in the Path column. The Action column indicates if
the key is included or excluded.

=] Exclude Paths @ Fegishy Keys |

Path | Action |
ZIHKEY_LOCAL_MACHINE \HARDWARE Exclude

% pdd. % Edt. | &> Remove |

Cloze /l

7

To change the action (include or exclude) on a selected key, click .
To delete selected keys from the list, click .
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At the heart of the discovery process are the types of data to be discovered from a
selected domain. From the Domains tab, you can configure one or more domains at a
time by holding down the CTRL or SHIFT keys, and then selecting the domains to
configure.

ﬁ Enterprise Security Reporter 3.0 !Eﬂ
File Tools Help

Bladd BEIE &l &
ra Computers rﬁ Discovery Gioups reﬁ Manage Discoveries l

Domain | Discaven DT | Domain Type | @ Items E ’ - i . . | G |

i@ Discovery Domain Controller

J Domains

Select discovery domain contraller:

| 8|

-3 Discovery Domain Athibutes

= Domain accounts

7 Sites

[ Trust relationshins

[T Domain cortrollers

= Domain computers

[T Organizational urits

= Synchrarize last lngon information

0 Lpply @ Schedule

Add. |@ Remove |

|Connectinn server=iM 4 wIN2KSYR dalabe| | ‘Licenses: 100 Remaining: 100
Add Add a domain to the list. See Adding Domains.

Remove selected domains.
Apply Save the selections for the current discovery.

() Schedule | Schedule a discovery. See Scheduling Discovery Jobs.

After adding domains and selecting the discovery domain controller, use these four
tabs to configure the domain discovery process:

It Select domain items to include in the discovery. See Selecting
| o [IEmE | Items for Domain Discovery.

Select Active Directory attributes to include in the discovery.

Al LiES See Selecting Active Directory Attributes.

Select organizational units to include in the discovery. See
Selecting Organizational Units.

| : | Set options for the domain discovery process. See Setting
Uptions Domain Discovery Options.

|i[ﬂ Organizational Lrits |
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Adding Domains

1. From the Discovery Console, open the Domains tab, and then click .
The Select Target Domain box appears. Expand the list to view the domains.

™ Select Target Domain [_ (O]

E--@ Desklop
[E!’ Wetwark Meighborhood
R A CniE R
#-43) Active Directary Select a domain or
type the name

Domain M ame: IACME| -

Ok | Cancel |
Vi

2. Select one or more domains from the list or type a domain name in the box.

3. Click OK. Each domain is listed along with the domain type.
O]}

ﬁ Enterprise Security Reporter 3.0
Ele Tools Help

3@ BT A 46l
@ Umamsra Computers rg‘g Dizcovery Groups r{:@ Manage Discoveres I

Domain I Discovery DC I Domain Type | @D ltems | 1 Attributes | \& Organizational Urits () Optiors |
@ ACME.COM Active Directory

& Dizcovery Domain Controller

[ Select dizcovery domain contraller

PO - — e

1)

— »

e A A N - e o s

[y, ey Ny b Gy S e gy ey G G ey, --'\-\_|,.

@ Add. |Q Femove

|Conneclion: server=Y4-WINZKEVR databe| |

To remove selected domains, click .

Important: When you remove a domain from the list, all discovery data for that

domain is deleted.

Licenses: 100 Remaining: 100

Selecting the Discovery Domain Controller
When a discovery is performed, the data collected is stored in the discovery
database, which is located on the discovery domain controller.

1.  On the Domains tab, select the domain in the left pane. The Items tab becomes
available.

2. In the Select discovery domain controller box, type the name of the domain
controller or click to locate a domain controller.
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3. Click . The selected discovery domain controller is listed in the
Discovery DC column in the left pane.
‘. Enterprise Security Reporter 3.0 !E E
File Tools Help

e @ BEIEA & R

Dormains I/a Computers I/gsg Discovery Groups I/r:g Manage Discoveries I

Domain

| Dizcovery DC

| Domain Type |
(L5 acme. com WM AAWINZES YR

&) ltems | i Altributes | i:'i Drﬁan\zationalUnits | ~10pt 4 )
Active Directory

[a Discovery Domain Controller

Select discovery domain contraller:
| VMAWINZKS R

8|

(&3 Discovery Domain Attibutes
VD

h accounts

W Trst relationships
V¥ Domain controllers
V¥ Domain computers
¥ Organizational units
[ Synchronize last logon information

@ Apply |Eﬂ Scheduls

PR R—
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Selecting Items for Domain Discovery

The Items tab contains types of data that you can select to include in the discovery

process.

1.

Open the Domains tab, and then select the domain. The Items tab becomes
available.
IM[=] E3
)

tnage Dizcovenes |

L

- D Items | ] Attibutes | {'ﬁ' Organizatianal Units | (ﬂ Optiohs |

-

* ~ i Discovery Domain Controller

Select dizcovery domain controller:

. [VMa-wWINZKSVR 1

Ll

-—QQ Dizcovery Domain Attributes

Domain accounts

Sites

Trugt relationships

Diomain controllers

Dramain computers

Organizational units

g [ Synchronize last logan information

¥

_—

EUR IR IR iR

4 @ Apply :"\' Schedule

-
) e . I T

I Domain accounts
By default, domain accounts are included in the discovery. To exclude domain

accounts, clear the check box.

W sites

By default, sites are included in the discovery. To exclude sites, clear the check
box.

¥ Trust relationships

By default, trust relationships are included in the discovery. To exclude trust
relationships, clear the check box.

¥ Domain controllers
By default, domain controllers are included in the discovery. You can configure

the discovery parameters for the domain controller on the Computers tab. See
Configuring Computers. To exclude domain controllers, clear the check box.
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¥ Domain computers

By default, domain computers are included in the discovery. You can configure
the discovery parameters for each computer on the Computers tab. See
Configuring Computers. To exclude domain computers, clear the check box.

2 Organizational units

By default, organizational units are included in the discovery. You can select
specific organizational units on the Organizational Units tab. See Selecting
Organizational Units. To exclude organizational units, clear the check box.

r Synchronize last logon information
Select to contact each domain controller in the domain, and retrieve the last log
on and log off dates/times for all users.

2. Make the selections to define the discovery process, and then click .

Selecting Active Directory Attributes

When discovering the domain controller for an Active Directory domain, you can

select additional LDAP attributes for group and user accounts. Since these additional
LDAP attributes are only gathered when discovering the domain controller of an
Active Directory domain, you must set that domain controller as the discovery
domain controller. See Selecting the Discovery Domain Controller.

1.

Open the Domains tab, select a domain, open the Attributes tab, and then click
. The Domain Attributes box appears.

From the Object type list, select the type of attributes to display. The choices are
All, User, Group, or Organizational Unit.

@ Domain Attributes [_ (O] x|
Obiject wpe: User j
Al |

Tupe | Dizplay Marme | -
user Group ) | Marne

uger Drganizational U.n't Logon Mame [prewindows 2000)

uzer aszistant Azziztant

uszer [ Country &bbreviation

uszer co Country

user comment Comment

uger company Compatny

uger department Department

uzer dezcription [rescription

uzer directR eports Direct Reports

uszer dizplaph ame Dizplay Mame

uzer digtinguishadh ame 500 Distinguished Mams ;I
v Show comman oK I Cancel |

W' Show common
Select to show only attributes in the list that have value in the Display Name
column.
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Important: If you select an attribute for which there is no value, the attribute

does not appear on a report, but appears to be part of the discovery process. To

be sure you select only attributes for which there is a value, select the Show
common check box, or use the ADSI Edit utility that is provided with Windows
XP/2000/2003.

To use the ADSI Edit utility:

1
2
3
4.
5
6

Click Start, and then choose Run.

In the Open box, type mmc, and then press Enter.

From the File menu, choose Add/Remove Snap-in.

Click Add, and then select ADSI Edit from the list of snap-ins.
Click Add, and then click Close.

Click OK, and then connect to the domain you want to check for attributes.

3. Select each attribute that you want to discover, and then click OK. The selected
attributes display.

Note: When the domain controller is discovered, the selected attributes are
added to the tblGroupAttribute and tblUserAttribute tables.

-

¥

* v T ¥

.

v

v3e Discoveries |
“I-
‘;— @Items [ Attributes mﬂrganizationaIUnits |r\, Options |
»
Tupe | Attribte | Dizplay narme |
[ user ch Mame
[ user company Company
[ user department Department
[ user employes| D Ermployes 1D
= ;
& Add. & Remove
P R i R T S e O —

To remove selected attributes from the list, click .

21 APRIL 2006



ENTERPRISE SECURITY REPORTER™ 3.0

17

Selecting Organizational Units

1. From the Discovery Console, open the Domains tab, select the domain, open the

Organization Units tab, and then click .

2. Expand the list, and then select the organizational units to discover.

3. Within the selected organizational units, choose to discover Computers, Groups,

or Users by selecting the corresponding check box.

[ specify Drganizational Units {OUs) =]

ACME. Com
1=y Builtin

B [ Computers

[1(€3 Domain Controllers
1) FareignS ecurityPrincipals
B I System

=

- [l Uszers
[T Computers
Discaver these items contained in the selected DU [ Groups
v Uszers

Ok I Cancel J/
23

4. Click OK. The selected organizational units display.

&
3

1

IS [=] E3

age Dizcoveries

@ Itemns | 'i Attributes i3 Drganizational Lirits |ri*i Detions |

Path | Applies to |

\'LH LDAP:ACH=Users DC=acme, DC=com User

{al add.. | Edit... |,_ Remove

T /.‘ g - a""‘]. -

(&
]
r
|

T e

To remove selected organizational units from the discovery, click .
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To modify selected organizational units, click . The Configure

Organizational Unit(s) box displays the current selection. You can choose to
change the items discovered in the selected OU. The choices are Computers,
Groups, or Users.

[ E3

.
° ‘EI? Discoveries
‘P‘

r
&[] tems Attributes @ Organizational Units Options

&
’ Path | Applies to |
'] LDAP: #/CH=Users DC=acme D C=com User
-
» Configure Organizational Unit(s)
5
'
]
I~ Computers
Dizcover these items contained in the selected OU[zk T Groups
¥ Users

N

Cancel

e

‘ {a add.. I@ Edi... |§.’J Remave

B e e s o ﬁin L IV T S W SR SR

Setting Domain Discovery Options

From the Discovery Console, open the Domains tab, select the domain, and then
open the Options tab.

< (<

-

’Qiscoveries |

4 P

- (Dtems | 3 avbutes | g Ogarizaonallnis | Drters

. H
; ¥ ¥Fing Timeout

X Fing timeout: I‘IDD millizeconds

[specify O for no timeout; max walue: 5000]

&

: A Chltemate Credentials
- Uzermame: I E
a Pazsword: I

. Thiz login information iz uzed for the discovery of

1 the zelected computer(s).

e O ooy |

]

"

el o Wl Bk B b AW AR
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¥ Ping Timeout

By default, the discovery engine abandons a discovery on a computer after 100
milliseconds. To change the value, type a number between 0 and 5000. If you do
not want the ping to time out, type 0.

For example, if you are adding a computer that is not active, the ping times out
at the value you specify.

¥ Computers Not Added H=]

The following computers could not be added:

Computer Mame I Reazon I
SWPC-A5E7E acme.com Computer could not be pinged,

v

I Alternate Credentials

Select to specify the user name and password of the account whose security
credentials you wish to use to discover a computer. You can specify one set of
credentials for one computer and another set for a different computer. This
process creates a network connection to a remote computer in the same way a
drive is mapped to a remote computer. If you already have a connection
established to the computer you wish to discover, the discovery agent uses the
credentials of the established connection instead of establishing a new
connection.

Note: By default, Enterprise Security Reporter connects to a computer using the
credentials of the logged-in user.

1. Inthe User Name box, type a user name, or click to select a name from
the Select Users or Groups list.

2. In the Password box, type the password.

5. Click[@ oo |
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If you select to discover domain controllers and domain computers on the Items tab,
you can configure the parameters to discover on the Computers tab.

ﬁ. Enterprise Security Reporter 3.0 !E ﬁ
File Tools Help

Bl BRIBIAIS
(D Domains /a Computers rﬁ Discovery Groups r@g Manage Discoveries l

Computer | Diomain | T_upal B ltems - i | ii . | E i .

9 Discovery P,

I™ Local accourts

I™ Local secuity policy

I™ Event log configuration

™ Frirters

T Services

™ Shares

™ Reqisty keps

= “olumes
T Folders I© Pemissions

I Al folders available through public shares

I™ Files [T Permissions

Apply |® Schedule |

E Add... |a Search.. |E Femaowve |

|Connection: server=yM4-WINZKSYR databe| | |Licanses: 100 Remaining: 100

B Add. Add a computer to the list. See Adding Computers.

i Search.. Search for computers to add to the list. See Searching for Computers.

B Femove Remove selected computers from the list.

Save the selections for the current discovery.

(D Schedule Schedule a discovery. See Scheduling Discovery Jobs.

il

After adding computers, use these four tabs to configure the computer discovery
process:

2 lems Select items to include in the discovery. See Selecting Items for
Computer Discovery.

=) Path Specify paths to include in or exclude from the discovery. See
e Including/Excluding Paths in/from the Discovery.

Select registry keys to include in or exclude from the discovery. See

@ Registy Keys Selecting Registry Keys for Discovery.

Set options for the computer discovery. See Setting Computer

& Dptions Discovery Options.

1717
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Adding Computers

Note: Only computers that can be pinged can be added to the list. To set the ping
timeout, see Setting Domain Discovery Options.

1. Open the Computers tab, and then click

box appears.

computers from the list.

B Add..

. The Select Target Computer

In the Computer Name box, type a single computer name, or select multiple

Note: Once you select a computer from the list, the Computer Name box

becomes unavailable.

1 Select Target Computer

IS [=1 E3

E--[@ Desktop
EI “ Metwork Meighborhood
| B Mg ACME
—J PC-45675
ED@ Active Directory
= D@ ACME. COMm
B~ 15 Builtin
E| 112y Computers
B[ % PC45ETS
E- (1@ Damain Contrallers
OB VMAWINZKSVR
115y Foreigns ecurityPrincipals
B ]I Swstem
- 112y Users

Computer Mare:

o]

Cancel |

3. Click OK. The selected computers display in the left pane.

Note: If a computer cannot be added, an error box displays the name of the

computer and the reason.

L Enterprise Security Reporter 3.0
File Tools Help

g @ 2EID & B

[l S |

& Domains /a Computers r(.:.,‘ Discovery Groups rc‘; Manage Discoveries l

B Add. |:_:1 Search... |E Femave |

_CD"“ uter | Domain | Type I & ltems |\ Patha | f Hegistry Keys [ ™ Options |
& vmd-winZkavr Primary L'omain Contraller
& PC-4s678 Member Server .
g Discoveny |
X N ( ™ Local accounts L . 1
M as pn PP N . ol - o —a e gl

T e B g W "“'-F'—-‘ ‘Po‘-'-*‘io'-wsﬂqﬂme\

|Connectinn: server=M 4 WIN2KEYR databe

| Licenzes: 100 Remaining: 100

To remove selected computers, click .
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Searching for Computers

Another way to add computers is by searching for specific computers by machine
type, computer name, or operating system. If you have a lot of computers, searching
for computers can be a time-saver.

1. Open the Computers tab, and then click . The Specify Scope box
appears.

2. Expand the list and select the domain that you want to search.

Computer Search

Specify Scope
Specify the domain(z] in which you wizh to search for computers.

@ Metwork Meighborhood
B [gfy ACME
E@ Active Directony

B- @ ACME. COMm
- ][ Builin
i Computers
Diomain Cortrollers
|| ForeignSecunityPrincipals
0 Swstem
- w2y Users

< Back I Mext > I Cancel |
3. Click Next. The Add Search Filters box appears.

Computer Search

Add SearchFilters
Lirnit pour zearch results by adding specific search cnteria.

Add...

Remove |

< Back Mest » | Cancel |

a. If you want to search for specific computers, click Add. The Add Search
Filter box appears.

b. From the Select Search field list, select the field to search:
Operating system version
Machine type

Computer name
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c. From the Select search operator list, select an operator:
Is equal to
Is not equal to
Contains

Does not contain

d. Inthe Enter value box, type the value upon which to search. Wildcards are
supported.

Add Search Filter

Select zearch field:
I Computer name j

Select zearch operator:
IEnntains j

Enter walue;

e ]

e. Click OK. The search filter displays.

Computer Search

Add SearchFilters
Lirnit wour search results by adding specific search ctena.

= E_nmputer harme Add..

i Containg 'PC*
Remove |

< Back Hest >

Cancel |

f. Repeat these steps to add more filters.
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4. Click Next. The Ignore List box displays.

a. If you want to eliminate computers from your search, type the complete

computer name in the box, and then click Add. The computer is added to the
list.

Computer Search

Ignore List
Computerz on thiz lizt will be ignored in your search.

Type the computer name,
q and then click Add

[N ZK SR

-
add |

Remove |

wmd-win2ksyr. acmme, com

Computers in this
list are ignored

< Back I Mest » I Cancel |

b. Repeat to add more computers to ignore in the search.

5. Click Next. The search begins. When the search is complete, a list of computers
appears.

Computer Search |

Search Resulks
Select the desired cormputers fram the search results belaw.

[ pc-45678. acme. com Check all |
[ pc-56754. acme. com
O pc-85764. acme. com Uncheck all |

< Back I Finizh I Cancel |

To select individual computers, select the corresponding check box.

To select all the computers, click Check all.
To clear the selection, click Uncheck all or clear the individual check box.

6. Click Finish. The selected computers are added to the list.

QEntErprisE Security Reporter 3.0 !EE
File Tools Help

Bl BE D&l B

D Domairs /a Computers r&‘g Digcovery Groups r{js Manage Discoveries I

Computer | Domain | Type | & ltems | " MBalks | P Fegisty Keps | Optiors |
& PC45678 Mernber Server
g Discovery P.
[T Local acoounts
[T Local security policy
- — » L - - 1l [T Ewert Iguco_nfigu@lion P N e ala
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Selecting Items for Computer Discovery

1.

Open the Computers tab, and then select one or more computers. The Items tab
becomes available.

ﬂ Enterprise Security Reporter 3.0 !E E
File  Tools Help
el BEIE & B
(&) Domains /a Computers rl.;., Discovery Groups r{g tanage Discoveries I
Cornputer I Domain I Type —I— & ltems | Paths I @ BegisipKeys | # Options
' wnd-winZksur Primary Domain Contraller
& PC-45678 Member Server 2 Dissovey P
¥ Local accounts
W' Local sscurity policy
¥ Eventlog configuration
¥ Printers
v Services
¥ Shares
™ Registry keys
¥ Volumes
[V Folders [V Pemissions
¥ &)l folders available through public shares
¥ Files V¥ Permissions
@ tpoly | & 5chedule
— - A & » - e m Rt M. m e — P = L

In the Items tab, select the items in the Discovery Parameters area to include in
the discovery.

W Local accounts
By default, local accounts are included in the discovery on the selected computer.
To exclude local accounts from the discovery, clear the check box.

M Local security policy

By default, the local security policy is included in the discovery on the selected
computer. To exclude the local security policy from the discovery, clear the check
box.

¥ Event log configuration

By default, the event log configuration is included in the discovery for the
selected computer. To exclude the event log configuration from the discovery,
clear the check box.

W Printers

By default, all the printers that are defined on a computer are included in the
discovery for the selected computer. If the printer is shared, the share name is
discovered and recorded also. To exclude printers from the discovery, clear the
check box.

M services

By default, all the services and devices that are defined on a computer are
included in the discovery for the selected computer. Includes devices that show
under the Devices applet in the control panel. To exclude services and devices
from the discovery, clear the check box.

W shares

By default, all file and administrative shares on a computer are included in the
discovery. To discover shared printers, select Printers as well. To exclude shares
from the discovery, clear the check box.
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[T Registry Keys

Select to catalog all the registry information that is defined on a computer and to
activate the Registry Keys tab. By default, registry keys are not included in the
discovery.

W Volumes

By default, all local logical drives installed on a computer are included in the
discovery. To exclude volumes from the discovery, clear the check box. If
cleared, the Folders, Folders Permissions, Files, and Files Permissions check
boxes become unavailable.

M Folders

Available only if the Volumes check box is selected. By default, folders
defined on a computer are included in the discovery. The behavior of this
option is dependent on the selections made on the Paths and Options tabs. If
selected, Folders Permissions is selected automatically. To exclude folders
from the discovery, clear the check box. If cleared, the Folders Permissions
check box becomes unavailable.

W  Permissions

Available only if the Volumes and Folders check boxes are selected. By
default, a complete list of folder permissions is included in the discovery. To
exclude folder permissions from the discovery, clear the check box.

¥ All folders available through public shares

Available only if the Folders check box is selected. By default, only the
folders and permissions under shares that are accessible to the general
public (excludes administrative shares) are included in the discovery. If
you want to include other folders that are not public, add the path on the
Paths tab. To include all data, clear the check box.

W Files

Available only if the Volumes check box is selected. By default, files defined
on a computer are included in the discovery. The behavior of this option is
dependent on the selections made on the Paths and Options tabs. If selected,
the Files Permissions check box is selected automatically. To exclude files
from the discovery, clear the check box. If cleared, the Files Permissions
check box becomes unavailable.

Important: Select the Files check box only if you specifically need
information about the files and their associated permissions. Discovering
files dramatically slows down the discovery process and increases the
amount of space required to store the data.

W Files Permissions

Available only if the Volumes and Files check boxes are selected. By default,
a complete list of file permissions is included in the discovery. To exclude file
permissions from the discovery, clear the check box.

5. Click[@ s |
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Including/Excluding Paths in/from the Discovery

You can refine the discovery scope by specifying specific folders on a computer that
are to be included in or excluded from the discovery. For example, you may care
only about a particular folder on a computer and the rest of the data may be
irrelevant to what you are working on. In this case, add the folder to the list of paths
to be included and only those paths are discovered. In another scenario, you may
have a folder that contains information that is of no concern to your security scan,
but it is in a publicly accessible area and it takes quite a bit of time to discover the
data in it. In this case, you can exclude that path from the discovery.

Note: This process configures paths on individual computers. To exclude a path on

all servers, see Excluding Paths on All Computers.

Note: If a path is listed as an include path, only that path and the paths beneath it are
discovered; the other folders on the drive are ignored.

Important: A path is included in the discovery even if the All folders available
through public shares check box is selected on the Items tab and the path is not
public.

Important: If you exclude a path and there is a shared folder within that path, those
folders are included in the discovery if the All folders available through public
shares check box is selected on the Items tab.

1. Open the Computers tab, and then select the computer to configure.

Note: Paths are configured on a per-computer basis. The Paths tab is not
available if multiple computers are selected.

2. Open the Paths tab, and then click . The Edit Path for Discovery box
opens.
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3. Expand the list to locate the path to add or type a path in the Select path above,
or enter single path below box.

Note: If you select a path from the list, the Select path above, or enter single
path below box becomes unavailable.

ﬂgEdit Path for Discovery H=] E3

EI[:LéI Desktop
&-§

Haee TN (TN
-- [ Documents and Settings
: ISy Program Files
- W) RECYCLER
I Swstem Yolume Information
B (11 WINNT
Bl [ WUTemp

Select path above, or enter single path below:

Select how pou want the path to be treated: € Include (%
Ok I Cancel |
A

4. Select whether to include or exclude the path from the discovery.

5. Click OK. The path displays in the Path column. The Action column indicates if
the path is included or excluded.

‘ Enterprise Security Reporter 3.0 !E E
Eile Tools Help

Bledd BEID &l

& Domains /a Computers r-g‘f-g Discovery Groups r(fs Manage Discoveries I

Computer I Dormain I Type i =] Path E | A
a ltems | L. Faths Reaistiy Feys Options
= Fomnd-win2ksvr Primary Domain Cantraller j—
& PCas678 Mernber Server
Path |Actiom |
|;| CARECYCLERY Exclude
\;| C:\Program Filesh Include
T add | Edit |,_'_ Remove |
v — IO o i S P S P PN S S W i

To change the action (include or exclude) on a selected path, click .
You also can double-click the path to toggle between Include and Exclude.

To delete selected paths from the list, click .

21 APRIL 2006



ENTERPRISE SECURITY REPORTER™ 3.0 29

Selecting Registry Keys for Discovery

Note: To enable the Registry Keys tab, you must select the Registry keys check box
on the Items tab for the selected computer.

1. Select the computer, open the Items tab and then select the Registry keys check
box to enable the Registry Keys tab.

2. Open the Registry Keys tab, and then click .

3. Expand the list to locate the key to add or type a path in the Select key above, or
type the key below box.

Note: If you select a key from the list, the Select key above, or type the key
below box becomes unavailable.

ﬂgsdect Registry Key H=1 E3

E--Q Registry
j My Cormputer [WM4-/M 2KSVR]
E\ [WIIE3 HEEY_LOCAL_MACHINE
¢ - HARDWARE
LB SAM
B0 SEEUHITY

B0 VS TEM
& C1e) HKEY_USERS

Select key above, or type the key below:

I [multiple checked]

Select how you want the key to be treated: @ |nclude  Exclude
ok I Cancel |

y

4. Select whether to include or exclude the key from the discovery.

5. Click OK. The key displays in the Path column. The Action column indicates if
the key is included or excluded.

. Enterprise Security Reporter 3.0 [_[O]
Elle Tools Help
Bl | BEIE & B
@Dﬂmams/a Computers r{g Discovery Groups r[fs Manage Discoveries l
ﬂw‘e'_lml_we—l— 8 tems | CIPathe | @ Fegsykers | ) Dtiens
vmd-winZksvi Primary Domain Controller
;a PC-45678 b smber Server
Fath [Action |
? HEEY_LOCAL_MACHINENSOFTWARE Inciude
@ HKEY_LDCAL MACHINENSYSTEM Exclude
& Add |’:}; Edit |ﬁ;; Remove
B P Y Sy R »r - e e e s A S

To change the action (include or exclude) on a selected key, click .

To delete selected keys from the list, click .
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Setting Computer Discovery Options

The options that you set for an individual computer override any other options that

were set on a global basis.

1. Open the Computers tab, and then select the computer to configure.

2. Open the Options tab.

w i; iiihi |ﬁ ﬁiii“ Eii # Dptions

A CBltemate Cradentials

Isermarne; I

Pazsword: I

Thiz login information iz uzed far the
dizcoveny of the selected computer|z).

]

A i@Discoverny Sarver

Discovery server:

Thiz dizscovery server will abways be used
dizcover the selected computer(s).

=]

ta

el '.J__j Folder Depth

Folder depth: I

Indicates hiw deep inta the higrarchy you
wizh to discover falders. Specify "0" to
dizcovery only the top-level paths to be
digcovered,

@ Appl |

[T Alternate Credentials

By default, Enterprise Security Reporter connects to a computer using the
credentials of the logged-in user. Select this check box to specify the user name
and password of the account whose security credentials you wish to use to

discover a computer.

You can specify one set of credentials for one computer and another set for a
different computer. This process creates a network connection to a remote
computer in the same way a drive is mapped to a remote computer. If you

already have a connection established to the computer you wish to discover, the

discovery agent uses the credentials of the established connection instead of

establishing a new connection.

In the User Name box, type a user name, or click to select a name. In the

Password box, type the password.
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™ Discovery Server

If you have more than one discovery server, by default, Enterprise Security
Reporter selects the next computer in the queue and assigns it to the first
available discovery server. Select this check box to assign a specific discovery
server for the discovery of the selected computer.

In the Discovery Server box, type the name of the discovery server or click
to locate a discovery server.

™ Folder Depth

By default, Enterprise Security Reporter discovers all nested folders below the
selected folder. Select this check box to specify the folder depth to use during the
discovery process.

In the Folder Depth box, type the number that represents the level below the
folder to which you want nested folders discovered. For example, to include
only the first level of subfolders, type 1.

5. Click[@ s |

USING DiISCOVERY GROUPS

To save time, create a discovery group to configure a discovery for multiple domains
and/or groups. You can set the discovery properties on the group, and then override
the properties on computers where you need to discovery something differently.

u Enterprise Security Reporter 3.0 !E[E
Fle Tools Help

Bl BEIE &R
(&) Domains ra Computers /{g Discovery Groups r{ﬂ M anage Discoveries I

2] Items | . Options |

~1@ Default Seftings

& YMAWINZKSYR

™ Use group's default settings

[ Discavery P,

" Local accounts

™ Local security policy

[ Event log configuration

" Prirters

[T Services

[” Shares

™ Registry keys

[T wolumes
[T Folders [T Permissions
T Files [T Pemizzions

IT Discover data under public shares only

O Apply |C"\ Schedule |

{L_q';,l Add Group Add Domain | %Add Computer | @ Remove |

Connection: server="M4-wWIN2KSWR databe

| Licenzes: 100 Remaining: 100
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Discovery Group.

Button Description

Add a group to the list. See Creating a Discovery Group.

Add domains to a selected group. See Adding Domains to a Discovery
Group.

Add computers to a selected group See Adding Computers to a

B Remove Remove selected groups, domains, and computers from the list.

After adding groups, use these two tabs to configure the group discovery process:

_|

ab Description

Select items to include in the discovery. See Selecting Items for

07l Items -
ead Group Discovery.

Set options for the group discovery. See Setting Group Discovery

B Options Options

i1

Creating a Discovery Group

1. Open the Discovery Groups tab, and then click . The New Group

box appears.

New Group

Group name:

)8 I Cancel |

2. In the Group name box, type a name for the discovery group, and then click OK.
The group name displays in the left pane.

ﬂ Enterprise Security Reporter 3.0 !E E
File Tools Help

e @ BEIEA & R

& Domains ra Computers /{5“# Discovery Groups £ Manage Discoveries I

\;u.nj Accounting i ltems | # [Oplions |
- .

r o Default Settings 5
P o

- - F - - »

. TR ST -

To remove selected groups, click .

Note: You can add domains and/or computers to the group. See Adding Domains
to a Discovery Group and Adding Computers to a Discovery Group. If you choose to
add a domain to the group, you need to use the Domains tab to configure the
domain for discovery as the Discovery Groups tab options are unavailable.
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Adding Domains to a Discovery Group

1. On the Discovery Groups tab, select a group, and then click .

The Select Domains list displays the domains available for selection.

ﬁ Select Domain(s) E3

Dromair | Dizcowverny DC | Diomain Tope |
CEacme.com  WMAWINZKSYR  Active Directory

] | Cancel

Note: Only the domains listed on the Domains tab appear in the Select Domains
list. If you do not see a domain listed, you need to add it. See Adding Domains.

2. Select one or more domains, and then click OK. The selected domains display
under the group name.

. Enterprise Security Reporter 3.0 H[=]
File Tools Help

gl BEID &R

(D Domains ra Computers /{g Discovery Groups r(ﬂ Manage Discoveries l

-] Accounting [1 ikems]
) acme.com

# Dptiars

© Default Settings |
- [ I Llse group's d_efault‘semng;_ _— . _ L’ -

»

o BT R o & B

To remove selected domains from a discovery group, click .

Adding Computers to a Discovery Group

1. On the Discovery Groups tab, select a group, and then, click .

The Group Computers list displays the computers available for selection.

Computer | D armain | Type |
] PC-45675 Member Server
O wmd-winZkswr Primary Domain Controller

OF. Cahcel

Note: Only the computers that are listed on the Computers tab appear in the
Group Computers list. If you do not see a computer listed, you need to add it.
See Adding Computers.
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2. Select the computers for the group, and then click OK The selected computers
display under the group name.
@k Enterprise Security Reporter 3.0 [_ (O] =]

File Tools Help

Bl eled BEIE & B

Domains r% Computers /{.5:.4 Discovery Groups r;j; Manage Discoveries I

=421 Accounting (2 items)
@ PCasE7a
ol WMAMWINZKSYR

P S

To remove selected computers from the group, click .

Selecting Items for Group Discovery

o Default Settings
- -l - - - - [

) tems | " Deliuns |

™ Use group's default
B - T A

settings

—

Note: The discovery items and options that you choose for the group apply to all
members of that group. If you want to override the configuration on an individual
domain, use the Domains tab. See Configuring Domains for Discovery. If you want to
override the configuration on an individual computer, see Overriding Group Discovery

Settings.

1. On the Discovery Groups tab, select a group name, click Items, if necessary.

i ltems | A DEtions |

~@ Default Settings

[T Usze qroup's default settings

1 Discoveny Parameters

[ Local accounts

[ Local security policy

[ Event log configuration

™ Printers

[ Services

[~ Shares

[~ Reqistry keys

[ wolumes
[T Folders [T Permissions

[T Al folders available thiough public shares

[T Filez [T Pemiszsions

@ sppby | G Schedule

2. Select the items in the Discovery Parameters area to include in the discovery.

BE use group’s default settings

Available only if an individual computer is selected in the left pane. See

Owerriding Group Discovery Settings.
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I Local accounts
Select to include local accounts in the discovery on the selected group.
By default, local accounts are excluded the discovery.

™ Local security policy
Select to include the local security policy in the discovery on the selected group.
By default, the local security policy is excluded from the discovery.

™ Event log configuration
By default, the event log configuration is included in the discovery for the
selected computer.

I Printers

By default, all the printers that are defined on a computer are included in the
discovery for the selected computer. If the printer is shared, the share name is
discovered and recorded also.

™ Services

By default, all the services and devices that are defined on a computer are
included in the discovery for the selected computer. Includes devices that show
under the Devices applet in the control panel.

™ shares
By default, all file and administrative shares on a computer are included in the
discovery. To discover shared printers, select the Printers check box as well.

[T Registry Keys
Select to catalog all the registry information that is defined on a computer and to
activate the Registry Keys tab.

" Volumes
By default, all local logical drives installed on a computer are included in the
discovery.

E Folders

Available only if the Volumes check box is selected. By default, folders
defined on a computer are included in the discovery. The behavior of this
option is dependent on the selections made on the Paths and Options tabs
on the Computers tab. If selected, the Folders Permissions check box is
selected automatically.

B Permissions
Available only if the Volumes and Folders check boxes are selected. By
default, a complete list of folder permissions is included in the discovery.

[E All folders available through public shares

Available only if the Folders check box is selected. By default, only the
folders and permissions under shares that are accessible to the general
public (excludes administrative shares) are included in the discovery. If
you want to include other folders that are not public, add the path on the
Paths tab. To include all data, clear the check box.
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B Files

Available only if the Volumes check box is selected. By default, files defined
on a computer are included in the discovery. The behavior of this option is
dependent on the selections made on the Paths and Options tabs on the
Computers tab. If selected, the Files Permissions check box is selected
automatically.

Important: Select the Files check box only if you specifically need
information about the files and their associated permissions. Discovering
files dramatically slows down the discovery process and increases the
amount of space required to store the data.

B Permissions
Available only if the Volumes and Files check boxes are selected. By default,
a complete list of file permissions is included in the discovery.

5. Click[@ s |

Setting Group Discovery Options

The options that you set for a group override any other options that were set on a
global basis.

1. Open the Discovery Groups tab, select the group to configure, and then open the
Options tab.

ltems | 3 Optians

A Cplemate Credentisls

Lzername: | EI

Pazzword: I

Thiz login information iz uzed far the
dizcovery of the zelected computer(s).

= éDiscover}l Server

Digcavern server | 3

This discoverny server will always be
uzed to dizcover the selected computer
[s)

A IFolder Depth

Folder depth: I

Indicates how deep into the hierarchy
wou wish to discover folders. Specify
"0" ta dizcovery anly the top-level paths
to be dizcoversd.

@ ool |

I Alternate Credentials

By default, Enterprise Security Reporter connects to a computer using the
credentials of the logged-in user. Select this check box to specify the user name
and password of the account whose security credentials you wish to use to
discover all the computers in the group.
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Note: If you want to specify different credentials for computers in the group, you
need to override the group’s settings. See Overriding Group Discovery Settings.

In the User Name box, type a user name, or click to select a name. In the
Password box, type the password.

r Discovery Server

If you have more than one discovery server, by default, Enterprise Security
Reporter selects the next group in the queue and assigns it to the first available
discovery server. Select this check box to assign a specific discovery server for the
discovery of the domains and computers in the selected group.

In the Discovery Server box, type the name of the discovery server or click
to locate a discovery server.

™ Folder Depth

By default, Enterprise Security Reporter discovers all nested folders below the
selected folder. Select this check box to specify the folder depth to use during the
discovery process.

In the Folder Depth box, type the number that represents the level below the
folder to which you want nested folders discovered. For example, to include
only the first level of subfolders, type 1.

2. Click[@ 2o |
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Overriding Group Discovery Settings

The discovery settings for the group apply to all the domains and computers in the
group. You may find it necessary to override the settings of the group for a particular
domain or computer. It may be a special case computer and you don’t want to
remove it from the group, but you do want slightly different settings.

Note: If you want to configure a domain separate from the group, open the Domains
tab and configure the domain on the Items tab. See Configuring Domains for Discovery.

1. Select the computer in the discovery group list, and then clear the Use group’s
default settings check box. The Discovery Parameters area and the Options tab
become available.

il Items | ' Optione |

.—'.J_ﬂ Default Settings

[ fse group'’s defaulf seffings

1w Discovery Parameters

¥ Local accounts

¥ Local security palicy

¥ Ewent log configuration

¥ Printers

¥ Services

¥ Shares

[ Registy keys

¥ Volumes
¥ Folders ¥ Permissions

¥ &l folders available through public shares

¥ Files ¥ Permissions

@ Apply ':_‘{J Schedule

2. Select the items for discovery of the selected computer. See Selecting Items for
Computer Discovery.

3. Set any options for discovery of the selected computer. See Setting Computer
Discovery Options.

1 Click[@ ey |
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To facilitate moving discovery configuration parameters between databases, or
simply for the purpose of backing up your discovery configuration, you can export,
and then import an ESR3 Discovery Configuration (*.xdc) file.

1. From the Tools menu, choose Export Discovery Configuration.
ESR 3 Discovery Configuration Files (*.XDC) displays in the Save as type box.

2. Inthe Save in box, locate a folder.

3. In the File name box, type the name for the file, and then click Save. A message
box confirms that the discovery configuration export is complete.

4. Click OK.

Discovery configuration settings are exported as ESR3 Discovery Configuration
(*.xdc) files.

1. From the Tools menu, choose Import Discovery Configuration.
ESR 3 Discovery Configuration Files (*.XDC) displays in the Files of type box.

2. In the Look in box, locate the folder where the file is stored.

3. Select the file to load, and then click Open. A message box confirms that the
discovery configuration import is complete.

4. Click OK.
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USING ENTERPRISE SCOPES

Enterprise scopes allow you to group multiple computers together, regardless of type
or discovery configuration, so that a single report can be run against the discoveries
done on those computers. You may wish to group computers together by function,
by type or by geographic location to name a few. Once you have the computers in the
enterprise scope, then you can select a report with the phrase “in scope” in the name
and that report will run against all the computers in the scope you select.

Note: Enterprise scopes allow you to prepare a report on various finished discoveries
on the named computers. If you want to group computers together to perform a
discovery, you want to create a discovery group. See Using Discovery Groups.

Adding Enterprise Scopes

1. From the Discovery Console, click . The Enterprise Scopes box opens.

2. Click . A new scope is added to the list.

ﬂ Enterprise Scopes !E[ E

'u.__—l I ew Scope

l.'j},' Mew scope... % Add computer... | |z| Remove

Close /l

L

3. Type a name for the scope, and then press ENTER or click anywhere in the
window.

ﬂ Enterprise Scopes !E[ E

-.:a;;' Mew scope... % Add computer. .. | |Z| Remove

Close /l

e

To rename a selected enterprise scope, press F2, type a name for the scope,
and then press ENTER or click anywhere in the window.

To remove a selected enterprise scope, click .

Note: Removing an enterprise scope removes only the definition of the scope
from the database. The discovery data associated with the computers in the is
unaffected.
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Adding Computers to an Enterprise Scope

= |
1. From the Enterprise Scopes box, select a scope, and then click .

The Enterprise Scope Computers list appears.

ﬁ Enterprise Scope Compukters !EI E
Computer | D amain | Type |
[ PC-45674 tMember Server
O 4N 2R SR Frimary Damain Contraller

ak I Cancel

2. Select the servers to add to the scope, and then click OK. The selected servers
display beneath the scope name.

ﬂ Enterprise Scopes !E[

l.:é},' Mew scope... % Add computer... | |Z| Remove

Close /l

7

To remove a selected computer from the enterprise scope, click .

Note: Removing a computer from the enterprise scope does not remove the
discovery data associated with that computer.

SCHEDULING DISCOVERY JOBS

1. Click @ Sehedde | 1.0 S eheduled Task Wizard opens.

2. Type a name for the task, select how often the discovery should run, and then
click Next.

3. Set the time, recurrence, and start date for the discovery job, and then click Next.
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4. Enter the user name and password of the account that can run the Discovery
Engine, and then click Next. The job summary displays.

] AccountingComputers

Windows will perfarm thiz tazk:
At 300 A every day, starting 3/1/2006

Scheduled Task Wizard E

Tou have succeszsiully scheduled the following task:

vy

Finizh.

pen advanced properties for this task when | click:

Click Firizh ta add this tazk ta vour wWindows schedule.

¢ Back I Finizh I

Cancel |

5. Select the Open advanced properties for this task when I click Finish checkbox,
and then click Finish. The Task tab opens.

6. In the Run box, add parameters after the closing quote mark. See Using the
Command-Line Utility: DiscoveryCMD.exe.

AccountingComputers

Tazk |Schedule| Settingsl Securityl

Q C:Wwf MM TAT azkahdoccountingComputers. job

Bur: iparationtES

Start in: "C:AProgram FileztSeriptLogic Corporation ESR 3hDiscove
Comments:
Run as ACME \Adminigtrator Set pazsward.
[+ Enabled [scheduled tazk runs at specified time)
0k I Cancel Anply

7. Click OK.
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LAUNCHING A DISCOVERY

The Discovery Monitor is a window into the discovery process enabling you to
control what happens while the discovery is running.

1. From the Discovery Console, click . The Select Discovery Engine box lists
the servers with the discovery engine installed.

EESEIECI: Discovery Engine E

Select the discovery engine that will process this job:

Computer Mame |

Ok I Cancel |

4

2. Select the server to run the discovery, and then click OK. To see the status of the
discovery, open the Manage Discoveries tab.

3. Inthe Select discovery server box, select the discovery server that is running the
discovery, and then click Refresh. The discoveries are listed in the Current
discovery queue list.

Note: If you want the Current discovery queue to refresh automatically, select
the Refresh every secs check box, and then change the duration, if desired.

fl Enterprise Security Reporter 3.0 M=l &3
File Tools Help

3@ BEIE AR

D Domains ra Computers r-,‘f-g Discovery Groups 2% Manage Discoveriss I

Discovery servers

[ Select: IVM4'W'IN2KSVF| j O Info.. Stop | i3 Install.. | io] Remove | ¥ Refresh every |5 secs. (% Refiesh |

Current discovery queue: Select job:

| Tupe | Path | status | Elspsed [ Prioriyy [ 1 [4/21/2006 - 11:34 M [Startec) =l

[ omain LO&P: //DC=acme,DC=com  Started  00:00:05  Momal [ - =

2 o Started 000020 Normal (R i-;! Delete Job |

Computer  pc-45678. acme.com Started  00:00:15  Mormal [
@ Status ¢ Loge © Emore
Obiject Type | Scan Count | Discover Count | Elapsed Time |
Group 21 2 2z
Group Member 19 19 2z
Uzer 1] 0 1s
Account Rights 35 35 1z
Audit Palicy 9 9 1z
Cormputer Palicy 9 9 1z
Ewent Log B E 1z
Printer 1 1 1s
Service 70 70 Es
Share 4 q 1s
Wolume 1 1 1s

4] | |

&8 Cancel |{}| {}l B Move |

|Conneclion: server=wM4-WIN2KSVR databas |Discnvery server: WM4WINZESVR 0 pending, 3 started Licenses: 100 Remaining: 58
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* status

By default, the status of the selected discovery displays. The status shows the
objects included in the discovery, how many objects were scanned and written to
the dbESR3.mdf file, and the length of time for each object type to be discovered.
To see the total length of time for the discovery, select Logs.

" Logs

Select to view the entries to the dbESR3_Log.dbf file that are associated with each
discovery job on an individual server. The log shows the total amount of time
elapsed for the discovery job.

" Errors
Select to view any errors generated during the discovery.

MANAGING THE DISCOVERY SERVER

You can control the ESR Discovery Engine service on the Manage Discoveries tab,
which offers the same functionality as the Services applet in Windows.

ﬂ Enterprise Security Reporter 3.0 !E[
File Tools Help

Bl BEIE &l
(& Domains ra Computers rd‘:d Discovery Groups /{S Manage Dizcoveries I
T @ Infa... ||E Stop |.g’i,,>;,_|nstall... |i.;’-n__,l Remave | I™ Refresh EVEW %805 (I Refresh |
- -~ & - ¥ w pnn g > . # -

~ s W - > ~ A »

L Select dizcovery server: |VMA-WINZESWR

Button Description
B Info Display information about the selected server. See Viewing Server
N Information.
[ stop Stop the ESR Discovery Engine service on the selected server.
[33 Start Start the ESR Discovery Engine service on the selected server.
£ Install.. Install the ESR Discovery Engine service on the selected server.
i.;:-} Rermove Remove the ESR Discovery Engine service from the selected server.
(& Refresh Update the Current discovery queue list.

" Refresh every secs.

Select to refresh the discovery queue by the specified number of seconds. By default,
the Current discovery queue list does not refresh until you click Refresh.
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Viewing Server Information

1.
2.

Open the Manage Discoveries tab.

From the Select discovery server list, select the discovery server, and then click
. The Discovery Server Information dialog box displays the current

settings for the selected discovery server.

ﬁ Discovery Server Information E

i Startup Parameters

Usemarme:

Password: I

Coanfirm passward: I

Startup mode: I.ﬁ.utomatic j

~ 4 Databaze Connection

& windows Authentication  Usemame: I
' 5OL Authentication Password: I
Server  [VM4-WINZKSVR =
Databaze: IdbESH3 j

w04 Concurrent Discoveries

Caoncurrent discoveries: |5

[Indicates the mawmurn number of
discovery processes you would like to run
zimultaneouisly. ]

Wergion: |3.D.D.D | g I Cancel |

Note: If you make any changes, you are prompted to restart the ESR3 Discovery
Engine service. The changes do not take effect until the service is restarted.

Startup Parameters
Displays the user name of the account running the Discovery Engine service. To

change to a different account, click and then type the password. You can
also specify the startup mode for the Discovery Engine service.

Database Connection
Displays the current discovery server and database. To connect to a different
server and database, choose the discovery server and database to use.

Concurrent Discoveries

So as not to overload the capabilities of your computer, the discovery engine
processes only a set number of servers concurrently. By default, the limit is set to
five in the Concurrent discoveries box.

If you increase the value, more servers begin processing immediately.

If you decrease the value, all currently running servers are allowed to finish,
and new discoveries can begin once the number of currently running servers
drops below the concurrent limit.
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MANAGING DISCOVERY JOBS

When you begin a discovery, the status of the job changes from Added to Started and
then to Finished. The color of the job reflects its status as well as the value in the
Status column. While a job is pending, you can move the job up and down the queue
or move it to a different discovery server. When a job is finished, it is available for
selection as the current discovery job, which is the job from which reports are
generated.

. Enterprise Security Reporter 3.0 =]
File Tools Help

W@ BEIE A B
& Domains ra Computers r{{-d Discavery Groups/""

-‘3 fanage Discoveries :

()

D\SCD\"S[_‘,' FEIVErS
{ Select: IVM4-WIN2KSVF| ﬂ 9 Infa... Stop | @ Install... i'_-’-} Remove | ¥ Refiesh every |5 TECT. @ Refresh |
Curment discovery queue: Select job:

Type | Path [ staws [ Elspsed [ Priority [ |4/21/200 - 11:39 AM (Firished) feunent) =
Diamain LDAP:#/DC=acme DC=com  Finished  00:00:06  Mormal o e

Computer  wmd-win2ksvr. acme. com tdded Mormal €6 Set Current |a§3 Delste Job |

Computer  pc-45678.acme. com Started 00:02:10  Mormal

& Status € Logs ¢ Enors
Ls » - - - F B Bt il e [ e e '“'MFI". — = 2l ]

Tﬂ‘#““'ﬂvﬁ-v»,{w#l MJ-W -l W vl WY WA

g Cancel ?l %l B Move
|Ennnectinn‘ semver=whl 4N 2K SWYR datahasn‘Discnvery zerver W 4-WINZESYR 1 pending, 1 started Licenses: 100 Remaining: 98
Button Description

3 Set Current Set the selected discovery job to current.

{73 Delete Job Delete the selected discovery job.

Cancel the selected pending or running discovery job. The status

W C |
&l Conce changes to Cancelled.

Move a pending job up the queue.

S|

Move a pending job down the queue.

Move a pending job to a different discovery server.

Note: To see a change in the discovery queue after you perform an action, you must

click or select the Refresh every secs. check box.

Note: If you want to stop a discovery job and restart it at a later time, cancel the job.
When the job status shows Cancelled, you can right-click the job, and then choose
Begin Discovery.
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MANAGING LICENSES

As soon as you start a discovery on a computer, a
Rap g S - -

license is applied. You can check the status bar to /7 %= R

see how many licenses you have and how many

are remaining. In this example, 2 licenses have 4 ||_icengeg; 100 Remaining: 92
been used out of 100, so 98 licenses remain.

To view the computers that were applied to your license count, choose View
licensed objects from the Tools menu. The Licensed Objects box lists the
computers on which discoveries were started.

ﬂ Licensed Objects [ x|

Object name | Object type |
ipo-4BE 78, acme. com Computer i
wmd-winZkzvr acme. com Computer

Unlock... | Cloze |

Important: If you started a discovery on a computer that you did not want applied to
your licenses, call ScriptLogic Technical Support to obtain an authorization code.

To unlock a computer, select the computer, and then click Unlock. In the
Authorization code box, type the code given to you, and then click OK.

Unlock Object

Object path: I pc-15678. acme. com

Authorization code:; I |
Ok, I Cancel |

USING THE COMMAND-LINE UTILITY: DISCOVERYCMD.EXE

In the Discovery Console folder of the installation directory, Enterprise Security
Reporter includes a command-line utility — DiscoveryCMD.exe — that you can use
to discover computers, domains, or groups manually.

Usage
DiscoveryCMD.exe "<type>

<object_path>" ''<discovery_engine>"

There are three types of discoveries: computer, domain, or group. The discovery
engine is the name of the computer where the ESR3 Discovery Engine is installed. If
you do not supply arguments, the command provides options from which you can
select arguments.

Example

DiscoveryCMD.exe "Computer', "mycomputer.testdomain.local™, "DISC_SERVER"
DiscoveryCMD.exe "Domain', '"LDAP://DC=testdomain,DC=local" "DISC_SERVER"
DiscoveryCMD.exe "Group", "Test Group", "DISC_SERVER"
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USING THE COMMAND-LINE UTILITY: PURGEDATA.EXE

In the Discovery Console folder of the installation directory, Enterprise Security
Reporter includes a command-line utility — PurgeData.exe — that clears data from
the discovery database. You can specify either a date or the number of days to use as

the basis of clearing data.

Usage
PurgeData.exe

/Date=""<date>"

/Days=""<number_of_days>"

Purges data from the discovery database.

[Optional]. All jobs older than the specified date
(but not including) are removed from the
discovery database.

[Optional]. All jobs that were discovered at least
the number of days specified prior to the current
date are purged from the database.

Note: You can specify a date or the number of days, but not both.

/Keep="<number_of jobs>"

[Optional]. Leave at least "n" jobs for each
discovery object.

For example, you specify 02/15/2006 as the date
and 10 as the number of jobs to keep. The
discovery database contains 12 jobs that
occurred before that date and 5 days that
occurred after that date. After you run the
command, only 7 of the jobs in the date range
are deleted because the "Keep" parameter
overrides the date/days parameters.

If you always want to keep the discovery data
from the current job, specify a "Keep" value of 1.
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Database Utilities

Use the Database Maintenance Wizard to manage the discovery and reporting
databases. The default discovery database is dbESR3.mdf and the default reporting
database is dbESR3Reporting.mdf.

rj-—Datahase Maintenance Wizard

Wwhat action would wou like to perform?

Remove an existing database
Increase database size
Shrink database

Run SGQL Scripk

Wiew database statistics
Attach Database

Detach Database

Checkpaint and Truncate Log
Save conneckion information
Perform DB mainkenance
Reset database securiby
Switch Server Security Mode 1
Set 'sa' password l

Cancel

| = Back | Mext = FEimish |

Note: Enterprise Security Reporter includes a run-time version of Microsoft SQL
Server 2000 Desktop Engine (MSDE 2000), which is data engine built and based on
core SQL Server technology. This database engine has some limitations over the full
version of Microsoft SQL Server 2000, such as a 2GB database limit and a restriction
on the number of concurrent users. If you have a large enterprise, you may want to
consider purchasing a full version of Microsoft SQL Server 2000 for use with this

product.
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STARTING THE DATABASE UTILITIES

There are three ways to start the Database Utilities.

From the Windows desktop, click Start, point to Programs » ScriptLogic
Corporation > Enterprise Security Reporter 3 > Database Utilities , and then
select either Discovery Database Wizard or Reporting Database Wizard.

From the Discovery Console, click E‘, and then choose either Discovery
Database or Reporting Database.

Note: Some actions, such as Removing a database and Detaching a database,
require that the database not be in use. For these actions, do not access the
Database Utilities from the Discovery Console.

From the command line, type DBWizard.exe. See Using the Command-Line Utility:
DBWizard.exe.

CREATING A NEW DATABASE

When you first install Enterprise Security Reporter, the Database Wizard opens
automatically for you to create new databases. The default discovery database is
dbESR3.mdf and the default reporting database is dbESR3Reporting.mdf.

Follow these this procedure if you bypassed this step during installation, or wish to
create another database to use.

Important: You must create a database before you can perform any tasks using
Enterprise Security Reporter 3. Databases created with Enterprise Security Reporter 3
are not compatible with those created with Enterprise Security Reporter 2 or 1.

1. From the Database Maintenance Wizard main page, select Create a new
database from the list, and then click Next. The database selection dialog box
displays the current computer and database names (default).

f§ Database Maintenance Wizard - Create a new database

SCL Database Server Name;
[z SR

Database Mame:
JdbSecRptzs

% Use Windows Authentication
i~ Use S0L Server Authentication

User Mame: I

Password: |

Cancel < Back Mext = Eimish
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10.
11.

12.

In the SQL Database Server Name box, type the name of the server that is
running MSDE 2000 or Microsoft SQL Server 2000, or click _| to locate a server.

In the Database Name box, type the name of the database to create or click lto
locate existing database names.

Note: The default discovery database is dbESR3.mdf. The default reporting
database is dbESR3Reporting.mdf.

The default selection for authentication is Use Windows Authentication. If you
select Use SQL Server Authentication, type the name of the SQL Server user
account in the User Name box and the password in the Password box.

Click Next. The database definition dialog box displays the default sizes for the
database (*.mdf) and transaction log (*.Idf) files.

"'-Datahase Maintenance Wizard - Create a new database

Initial Database Size: ISD
Initial TX Lag Size: ISD

™ override Default File Locations

Data File Path: |

T Log Path: |

{The paths above should be the local path on the server
where the database will be created. Ex: "C:ADEYV"
¥ Create default security groups
Create security groups as...

" Domain Groups
™ Domain Local Groups
¢ Local Groups {non-DC's only)

Cancel | Eimisti |

In the Initial Database Size box, type an initial size for the database file (*.mdf
file). If the database needs to grow the data file, it will do so automatically.

In the Initial TX Log Size box, type an initial size for the database transaction log
file (*.Idf). If the database needs to grow the log file, it will do so automatically.

To create the database transaction log files in a location other than the default
location, select Override Default File Locations, and then type the physical path in
the appropriate boxes. Express the path as a logical path and not as a UNC path.

By default, default security groups are created as local groups on non-domain
controllers only. You can select to create default domain groups or domain local
groups. To bypass the creation of default security groups, clear the Create
default security groups check box.

Click Next. The Database Maintenance Wizard displays the options you chose.

To create the specified database, click Finish.

As the action runs, a progress bar displays the action occurring and the progress
towards completion. When the action is finished, a message box appears.

Click OK.
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REMOVING AN EXISTING DATABASE

Removing a database permanently removes it from the system. If you just want to
detach the database, see Detaching a Database.

Note: The database cannot be in use. Exit the Discovery Console, if necessary, and
then start the Database Maintenance Ultility.

1.

From the Database Maintenance Wizard main page, select Remove an existing
database from the list, and then click Next. The Database Maintenance Wizard
displays the database selection options.

In the SQL Database Server Name box, type the name of the server where the
database is located, or click _| to locate the server.

In the Database Name box, type the name of the database to remove or click =
to locate the database.

Choose whether Windows or SQL Server Authentication is used. If you select
Use SQL Server Authentication, type the name of the SQL Server user account
in the User Name box and the password in the Password box.

Click Next. The Database Maintenance Wizard displays the options you chose.
Caution: Removing a database deletes it permanently from the system.

To permanently delete the database, click Finish.

As the action runs, a progress bar displays the action occurring and the progress
towards completion. When the action is finished, a message box appears.

Click OK.

INCREASING DATABASE SIZE

Microsoft SQL Server automatically increases the size of the database file as needed,
but if this happens while discoveries are running, it can significantly slow down the
discovery process. If a discovery process seems to be running normally, and then

suddenly slows down, you may want to increase the size of the database manually.

1.

From the Database Maintenance Wizard main page, select Increase database
size from the list, and then click Next. The Database Maintenance Wizard
displays the database selection options.

In the SQL Database Server Name box, type the name of the server where the
database is located, or click _| to locate the server.

In the Database Name box, type the name of the database to resize or click to
locate the database.

Choose whether Windows or SQL Server Authentication is used. If you select
Use SQL Server Authentication, type the name of the SQL Server user account
in the User Name box and the password in the Password box.
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Click Next. The Database Maintenance Wizard displays the existing size of the
database.

'Ii-Datahase Maintenance Wizard - Increase database size

Increase Database Size:

Existing Database Size: Il 57 MB
Mew Database Size: I

Note: Enter the total size of the new database, not the additional size of the
database. For example, if the database is 50MB and you want to add another
50MB, then you would enter 100 as the new database size.

In the New Database Size box, type a numeric value in megabytes that is greater
than the existing value and represents the total size of the database, and then
click Next. The Database Maintenance Wizard displays the options you chose.

Click Finish, and then click OK.

SHRINKING A DATABASE

If you need to reclaim space, you can shrink the database, which reduces the size of
the database to the minimum amount based on the size of the data.

Another database to monitor is the tempdb database, which is the working area that
Microsoft SQL Server uses to process queries and perform other actions. You might

shrink the tempdb database periodically to reclaim the disk space that is no longer
needed.

1.

From the Database Maintenance Wizard main page, select Shrink database
from the list, and then click Next. The Database Maintenance Wizard displays
the database selection options.

In the SQL Database Server Name box, type the name of the server where the
database is located, or click _| to locate the server.

In the Database Name box, type the name of the database to shrink, or click _|
to locate the database.

Choose whether Windows or SQL Server Authentication is used. If you select
Use SQL Server Authentication, type the name of the SQL Server user account
in the User Name box and the password in the Password box.

Click Next. The Database Maintenance Wizard displays the options you chose.
Click Finish, and then click OK.
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RUNNING AN SQL ScRIPT

1.

From the Database Maintenance Wizard main page, select Run SQL Script from
the list, and then click Next. The Database Maintenance Wizard displays the
database selection options.

In the SQL Database Server Name box, type the name of the Microsoft Windows
server where the database is located, or click _| to locate the server.

In the Database Name box, type the name of the database on which to run the
SQL script, or click _I to locate the database.

Choose whether Windows or SQL Server Authentication is used. If you select
Use SQL Server Authentication, type the name of the SQL Server user account
in the User Name box and the password in the Password box.

Click Next. The Database Maintenance Wizard displays the SQL Script selection
box.

In the Select a SQL Script file to run box, type the full path to the SQL Script File
(*.sql) or click .| to locate the file. Click Next. The Database Maintenance
Wizard displays the options you chose.

Click Finish. A progress bar shows the progress of the action. Upon completion,
the Output message box opens to the Results tab. To see messages regarding the
action, open the Messages tab.

Click Close, and then click OK.

VIEWING DATABASE STATISTICS

View the current database settings and statistics on the size of the database and each
table in the database, which is helpful for diagnosing problems in the event that SQL
Server is not functioning properly.

1.

From the Database Maintenance Wizard main page, select View database
statistics from the list, and then click Next. The Database Maintenance Wizard
displays the database selection options.

In the SQL Database Server Name box, type the name of the server where the
database is located, or click _| to locate the server.

In the Database Name box, type the name of the database, or click | to locate
the database.

Choose whether Windows or SQL Server Authentication is used. If you select
Use SQL Server Authentication, type the name of the SQL Server user account
in the User Name box and the password in the Password box.

Click Next. The Database Maintenance Wizard displays the options you chose.
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6.

7.

Click Finish, and then click OK. The Output dialog box opens to the Messages
tab, which displays the database statistics.

T Output M=

Results  Messages |

Create Date: 2005-03-25 09:44:12.857
Size: 153ME

Available: 67.82MB

Skakus: 0

Cwner: ACMELAdministrator

MNumber of Users: 3

Drata Space Used: 39,165KE

DATABASE: dbSecRpt2s j

GROUP: PRIMARY, FILE: dbSecRpt2S_Data.MDF
Phyysical Mame: C:iProgram Files\Microsoft SQL ServeriMSS0LdbSecRpt2s_Data.
Size: 103MB

FILE: dbSecRpteS_Log.LDF
Physical Mame: C:\Program Files\Microsoft SQL ServeriMssQLidbSecRpt25_Log.LD
Size: SOME

TABLE: thlaccountRight
Table Space Used: KB
Index Space Used: S0KE
Owner: dbo
Rows: 46

=
«| | »

To save or print the output, right-click in the box, choose Select All. Right-
click the selection, and then choose Copy. Paste from the clipboard into an
application of your choice.

When you are finished viewing the statistics, click Close.

ATTACHING A DATABASE

When you create a database, it is automatically attached to Enterprise Security
Reporter. If you detach a database, you can attach it again to use it.

1.

From the Database Maintenance Wizard main page, select Attach database from
the list, and then click Next. The Database Maintenance Wizard displays the
database selection options.

In the SQL Database Server Name box, type the name of the server where the
database is located, or click _| to locate the server.

In the Database Name box, type the name of the database to attach, or click to
locate the database.

Choose whether Windows or SQL Server Authentication is used. If you select
Use SQL Server Authentication, type the name of the SQL Server user account
in the User Name box and the password in the Password box.

Click Next. The data file selection box appears.

In the Select the MDF (data) file to attach box, type the full path to the data file
or click _I to locate the data file to attach.

Click Next. The Database Maintenance Wizard displays the options you chose.
Click Finish, and then click OK.
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DETACHING A DATABASE

Detaching a database removes it from Enterprise Security Reporter, but does not
delete it from the system. To permanently delete a database, see Removing an Existing
Database.

Note: The database cannot be in use. Exit the Discovery Console, if necessary, and
then start the Database Maintenance Utility.

1. From the Database Maintenance Wizard main page, select Detach database
from the list, and then click Next. The Database Maintenance Wizard displays
the database selection options.

2. Inthe SQL Database Server Name box, type the name of the server where the
database is located, or click _| to locate the server.

3. In the Database Name box, type the name of the database to detach, or click e
to locate the database.

4. Choose whether Windows or SQL Server Authentication is used. If you select
Use SQL Server Authentication, type the name of the SQL Server user account
in the User Name box and the password in the Password box.

5. Click Next. The Database Maintenance Wizard displays the options you chose.

6. Click Finish. The Output message box opens to the Messages tab, which
displays information about the process.

To save or print the output, right-click in the box, choose Select All. Right-
click the selection, and then choose Copy. Paste from the clipboard into an
application of your choice.

7. Click Close, and then click OK.

TRUNCATING THE TRANSACTION LOG

When a transaction log becomes full, it forces the database to expand it. However,
since Enterprise Security Reporter does not use the transaction log, and there is no
way to disable the transaction log for a database, you may need to periodically
truncate the transaction log to tell the SQL Server that the data is no longer needed.

1. From the Database Maintenance Wizard main page, select Checkpoint and
Truncate Log from the list, and then click Next. The Database Maintenance
Wizard displays the database selection options.

2. In the SQL Database Server Name box, type the name of the server where the
database is located, or click _| to locate the server.

3. In the Database Name box, type the name of the database whose log file you
want to truncate, or click _I to locate the database.

4. Choose whether Windows or SQL Server Authentication is used. If you select
Use SQL Server Authentication, type the name of the SQL Server user account
in the User Name box and the password in the Password box.
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5.
6.

Click Next. The Database Maintenance Wizard displays the options you chose.
Click Finish, and then click OK.

SAVING CONNECTION INFORMATION

This option writes the database connection settings to the registry.

1.

From the Database Maintenance Wizard main page, select Save connection
information from the list, and then click Next. The Database Maintenance
Wizard displays the database selection options.

In the SQL Database Server Name box, type the name of the server where the
database is located, or click J to locate the server.

In the Database Name box, type the name of the database, or click | to locate
the database.

Choose whether Windows or SQL Server Authentication is used. If you select
Use SQL Server Authentication, type the name of the SQL Server user account

in the User Name box and the password in the Password box.

Click Next. The Database Maintenance Wizard displays the settings to be

written to the registry.

Click Finish, and then click OK.

PERFORMING DATABASE MAINTENANCE

Performing regular database maintenance can help maintain the performance of SQL
Server. Run this action if you feel SQL Server is not performing at the same level it
once did. You can select to rebuild indexes, reset identify columns, and perform
consistency checks.

Many SQL database administrators are familiar with Database Consistency Checker
(DBCC) commands. The Perform DB Maintenance action performs the following

DBCC commands.

DBCC Command Description

CHECKCATALOG Checks the system tables for consistency.

CHECKFILEGROUP | Performs a physical consistency check on all indexes and tables.

CHECKTABLE Performs a consistency check of the data in each table and rebuilds

REPAIR_REBUILD indexes if necessary.

CHECKIDENT Checks the identity values of each table and resets them if
necessary.

CHECKINDEX Checks the physical database allocation of indexes and repairs if
necessary.
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8.

From the Database Maintenance Wizard main page, select Perform DB
Maintenance from the drop-down list, and then click Next. The Database
Maintenance Wizard displays the database selection options.

In the SQL Database Server Name box, type the name of the server where the
database is located, or click _I to locate the server.

In the Database Name box, type the name of the database, or click | to locate
the database.

Choose whether Windows or SQL Server Authentication is used. If you select
Use SQL Server Authentication, type the name of the SQL Server user account
in the User Name box and the password in the Password box.

Click Next. The maintenance options selection box appears.

',.'-Datahase Maintenance Wizard - Perform DB maintenance | x|

Select the maintenance options to perform:
[ Rebuild Indexes
I Reset Identity Columns
[~ Perform Consistency Checks

. - e - . -

V¥ Rebuild Indexes
Select to run CHECKINDEX and CHECKTABLE REPAIR_REBUILD.

¥ Reset Identify Columns
Select to run CHECKINDENT.

¥ perform Consistency Checks
Select to run CHECKCATALOG, CHECKFILEGROUP, CHECKTABLE
REPAIR_REBUILD, and CHECKINDEX.

Choose the maintenance options to perform, and then click Next. The Database
Maintenance Wizard displays the actions to be performed.

Click Finish. When the process is complete, the Database Maintenance Results
box opens to the Messages tab.

To save or print the output, right-click in the box, choose Select All. Right-
click the selection, and then choose Copy. Paste from the clipboard into an
application.

Click Close, and then click OK.

RESETTING DATABASE SECURITY

Resetting the database security re-creates the Windows NT security groups, database
roles, and logins, and then re-applies the default security to all
tables/functions/stored procedures in the Enterprise Security Reporter database.

1.

From the Database Maintenance Wizard main page, select Reset database
security from the list, and then click Next. The Database Maintenance Wizard
displays the database selection options.

In the SQL Database Server Name box, type the name of the server where the
database is located, or click _| to locate the server.
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In the Database Name box, type the name of the database, or click | to locate
the database.

Choose whether to use Windows or SQL Server Authentication. If you select Use
SQL Server Authentication, type the name of the SQL Server user account in the
User Name box and the password in the Password box.

Click Next. The Database Maintenance Wizard displays actions to be
performed.

Click Finish, and then click OK.

SWITCHING THE SERVER SECURITY MODE

Depending on your system setup, you may want to switch the security mode on the
SQL Server to enhance performance of some applications. For example, if you have
Active Administrator™ set up to use one mode and Enterprise Security Reporter to
use the other, you may want to switch the security mode on the SQL Server to SQL
Server and Windows.

1.

6.

7.

From the Database Maintenance Wizard main page, select Switch Server
Security Mode, and then click Next. The Database Maintenance Wizard
displays the database selection options.

In the SQL Database Server Name box, type the name of the server where the
database is located, or click _| to locate the server.

In the Database Name box, type the name of the database, or click | to locate
the database.

Choose whether to use Windows or SQL Server Authentication. If you select Use
SQL Server Authentication, type the name of the SQL Server user account in the
User Name box and the password in the Password box.

Click Next. The Database Maintenance Wizard displays the security mode
options.

'I.'-Datahase Maintenance Wizard - Switch Server Security Mode

Switch the Security Mode of SQL Server to the following:

® 50U Server and Windows

 windows only

o P P .

Select either SQL Server and Windows or Windows only, and then click Next.
The Database Maintenance Wizard displays the actions to be performed.

Click Finish, and then click OK.
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SETTING THE ‘SA’ PASSWORD

If the SQL Server is set up in mixed mode (SQL Server and Windows), set a
password for the SQL Server administrator (“sa” account). You also can use this
option to change the password for security purposes.

1. From the Database Maintenance Wizard main page, select Set ‘sa’” password,
and then click Next. The Database Maintenance Wizard displays the database
selection options.

2. In the SQL Database Server Name box, type the name of the server where the
database is located, or click J to locate the server.

3. In the Database Name box, type the name of the database, or click | to locate
the database.

4. Choose whether Windows or SQL Server Authentication is used. If you select
Use SQL Server Authentication, type the name of the SQL Server user account
in the User Name box and the password in the Password box.

5. Click Next. The Set “sa” password box opens.

'Ii-Datahase Maintenance Wizard - Set 'sa’ password

Enter the old "sa" account password:

Enter a new password For the "sa" account:

Please canfirm the password:

»r " N » R T

In the Enter the old “sa” account password box, type the existing password.
In the Enter a new password for the “sa” account box, type the new password.

In the Please confirm the password box, retype the new password.

L N

Click Next. The Database Maintenance Wizard displays the actions to be
performed.

10. Click Finish, and then click OK.

MoOVING A DATABASE TO ANOTHER SERVER

If you need to move a database from one server to another, we recommend using the
Microsoft SQL Server 2000 client utilities.

Note: Client utilities are available only on a full version of SQL Server 2000, which is
not included with Enterprise Security Reporter 3.

1. Open SQL Enterprise Manager.

2. Locate the database to move, right-click, point to All Tasks, and then choose
Detach Database.
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3. Open the folder where the data files for that database are stored, and then copy
the *.mdf and *.1df files for that database to the new server.

4. In SQL Enterprise Manager, navigate to the new server where you want to attach

the database, right-click

on the Database folder, point to All Tasks, and then

choose Attach Database.

5. Select the *.mdf file you just copied to the computer, and then complete the

operation.

USING THE COMMAND-LINE UTILITY: DBWIZARD.EXE

In the Database folder of the installation directory, Enterprise Security Reporter
includes a command-line utility — DBWizard.exe — that starts the Database

Maintenance Utility.

Specifying Database Connection Information

/SERVER=""[server-name]"’

Name of the server running SQL Server.

/DATABASE="[database-name]” Name of the database.

/USERNAME=""[username]™

/PASSWORD=""[password]"

[Optional] Name of the SQL Server user account.

[Optional] Password for the SQL Server user
account.

Note: If you do not specify a user name and password, trusted security is used.

Creating a Database

/CREATE

/DBSIZE="[size]"
/LOGSIZE="[size]"

/DBPATH="[mdf-path]"

/LOGPATH="[1df-path]"

Dropping a Database

/DROP

Running a SQL Script

/RUN=""[script-path]"

Create the specified database.
Important: Database must not already exist.

[Optional] Initial size of the *.mdf file (data).
[Optional] Initial size of the *.1df file (log).

[Optional] Full path to the *.mdf file, including the file
name.

[Optional] Full path to the *.1df file, including the file
name.

Drop the specified database.

Run the specified SQL Server script.
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Running All Maintenance Tasks

/MAINT Run all the maintenance tasks supported by the wizard.
See Performing Database Maintenance.

Running Checkpoint and Truncate Log

/TRUNCATE Truncate the log file of the specified database.

Shrinking the Database Files

/SHRINK Shrink the database file.

/LOGONLY Shrink only the log file and not the database file.

Resetting Database Security

/RESETSECURITY Reset the database security and add accounts if
necessary

Controlling Wizard Behavior

/QIUIET] [Optional] Do not display any user interface elements.

/CLOSEONFINISH [Optional] Close the wizard automatically when finished
(not applicable for QUIET mode).
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Troubleshooting

ScriptLogic Corporation has a library of articles in its Knowledge Base, which may provide
an answer to a problem you are experiencing. Before calling technical support, check to see if
your problem is documented here. You might also browse the Discussion Forums to see if
anyone else is experiencing the same issue.

http://www.scriptlogic.com/support

If you are running discoveries against a remote database, you might want to adjust
the rate at which the Discovery Engine records the status of discovery jobs in the
discovery database. The default rate is 5 seconds. The valid range is 1-60 seconds.
HKEY_LOCAL_MACHINE\SOFTWARE\ScriptLogic Corporation\Enterprise
Security Reporter\v3\Config

Value Name: DiscoveryStatusUpdatelnterval

Value Type: REG_DWORD (decimal)

Default Value: 5

If you need to uninstall the Discovery Engine, type the following at the command
line on the computer on which it is installed:

C:\WINDOWS\Microsoft_NET\Framework\v1.1.4322\Installutil.exe" /u
ESR3DiscoveryEngine.exe
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.sql file, 54
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removing attributes from discovery, 16
adding
computers to discovery, 21, 22
computers to discovery group, 33
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domains to discovery group, 33
enterprise scopes, 40
path to discovery, 27
ADSI Edit, 16
alternate credentials, 19, 30, 36
assigning
discovery server, 31
attaching
databases, 55

B

beginning
discovery, 43

C

cancelling
discovery job, 46

command line utility
DBWizard.EXE, 61
DiscoveryCMD.exe, 47
PurgeData.exe, 48

computers
adding to discovery, 21, 22
adding to discovery group, 33
adding to enterprise scope, 41
configuring for discovery, 20
removing from discovery, 21
searching for, 22
selecting groups for discovery, 34
selecting items for discovery, 25
setting discovery options, 30

concurrent discoveries, 45

configuring
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computers for discovery, 20

domains for discovery, 11
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to a computer, 19

to discovery database, 45
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databases, 50

discovery group, 32
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database utilities
starting, 50
databases
attaching, 55
creating, 50
detaching, 56
increasing size, 52
maintaining, 57
moving to another server, 60
removing, 52
resetting security, 58
setting sa password, 60
shrinking, 53
switching server security mode, 59
viewing statistics, 54
DBCC commands, 57
dbESR3.mdf, 49
dbESR3_Log.mdf, 44
dbESR3Reporting.mdf, 49
DBWizard.exe, 61
deleting
discovery groups, 32
discovery job, 46
paths from discovery, 9
registry keys from discovery, 10, 29
detaching
databases, 56
DiscoverCMD.EXE, 61
discovering
Active Directory attributes, 15
computers, 21
domain accounts, 14
domain computers, 15
domain controllers, 14
event log configuration, 25, 35
file permissions, 26, 36
files, 26, 36
folder permissions, 26, 35
folders, 26, 35
group local accounts, 35
LDAP attributes, 15
local accounts, 25
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shares, 25, 35
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volumes, 26, 35
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starting, 43
status, 44
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exporting, 39
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saving, 39
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cancelling, 46
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setting current, 46
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ping timeout, 19
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discovery queue
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discovery server
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moving jobs, 46
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stopping, 44
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discovering, 15
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discovering, 14
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adding, 12
adding to discovery group, 33
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deleting from discovery group, 33, 34
removing, 11, 12
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setting discovery options, 18
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adding, 40
adding computers, 41
removing, 40, 41
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errors
discovery, 44
ESR3 Discovery Configuration file, 39
event log configuration
discovering, 25, 35
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paths from discovery, 27
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exit program, 4
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discovering permissions, 36
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discovering, 26, 35
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global discovery options
setting, 8

group discovery
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